Design Overview

The CAN-to-Wi-Fi® Gateway is a reference design that shows how to add Wi-Fi connectivity to a CAN network. The design provides a simple way for users to gain access to the CAN bus traffic through a web site. This connection can be used for diagnostics or to add the capability to control the CAN bus. This TI Design provides a complete solution with design files and test results.

Design Features

- Adds Wi-Fi Connection Capability to Controller Area Network (CAN) bus
- CANopen Interface Provides Industry Standard Connection
- Compatible with ISO11898-2 Compliant Systems
- 5-V Power Input for Easy Integration With Existing Systems

Featured Applications

- Building Automation
- Compressors
- Heating, Ventilating, and Air Conditioning (HVAC)
1 Key System Specifications

Table 1. Key System Specifications

<table>
<thead>
<tr>
<th>PARAMETER</th>
<th>SPECIFICATION</th>
<th>DETAILS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input voltage</td>
<td>5-V DC nominal</td>
<td>See Section 4.4</td>
</tr>
<tr>
<td>Power connector</td>
<td>Micro USB</td>
<td>See Section 4.4</td>
</tr>
<tr>
<td>Interface</td>
<td>CAN</td>
<td>See Section 4.1</td>
</tr>
<tr>
<td></td>
<td>Wi-Fi</td>
<td>See Section 4.3</td>
</tr>
<tr>
<td>CAN connector</td>
<td>DB-9 wired for CANopen</td>
<td>See Section 4.1</td>
</tr>
</tbody>
</table>

2 System Description

The TIDA-00380 reference design is a controller area network CAN bus to Wi-Fi® gateway. The circuit is powered by a standard USB charger. The 5 V from the charger powers the SN65HVD256 CAN transceiver directly. The rest of the circuit operates from 3.3 V provided by a TLV1117LV33 linear regulator. The TM4C123GH6 microcontroller (MCU) has a CAN module that interfaces directly with the transceiver. Data is sent to the SimpleLink Platform CC3100 Module through a serial peripheral interface (SPI). The CC3100MOD transmits the CAN network data or receive commands for the MCU to put onto the CAN network. For this design, the CC3100MOD acts as a Wi-Fi access point (AP). A web site with the current CAN transaction is broadcast to any connected device with a web browser. The flexibility of the CC3100 module allows many different possible operation scenarios and the designer can use the TIDA-00380 reference design hardware in a number of different ways.

Figure 1. CAN to Wi-Fi® Gateway
## 3 Block Diagram

![Block Diagram](image)

**Figure 2. TIDA-00380 System Block Diagram**

### 3.1 Highlighted Products

#### 3.1.1 CC3100MOD

Add Wi-Fi to low-cost, low-power microcontrollers (MCUs) for Internet of Things (IoT) applications. The CC3100MOD is an FCC, IC, CE, and Wi-Fi® CERTIFIED module and is part of the new SimpleLink Wi-Fi family that dramatically simplifies the implementation of Internet connectivity. The CC3100MOD integrates all protocols for Wi-Fi and Internet, which greatly minimizes host MCU software requirements. With built-in security protocols, the CC3100MOD solution provides a robust and simple security experience. Additionally, the CC3100MOD is a complete platform solution including various tools and software, sample applications, user and programming guides, reference designs, and the TI E2E™ support community. The CC3100MOD is available in an LGA package that is easy to lay out with all required components including serial flash, RF filter, crystal, and passive components fully integrated. The Wi-Fi network processor subsystem features a Wi-Fi Internet-on-a-Chip and contains an additional dedicated ARM MCU that completely off-loads the host MCU. This subsystem includes an 802.11 b/g/n radio, baseband, and MAC with a powerful crypto engine for fast, secure Internet connections with 256-bit encryption. The CC3100MOD module supports Station, Access Point, and Wi-Fi Direct modes. The module also supports WPA2 personal and enterprise security and WPS 2.0. This subsystem includes embedded TCP/IP and TLS/SSL stacks, HTTP server, and multiple Internet protocols. The power-management subsystem includes an integrated DC-DC converter with support for a wide range of supply voltages. This subsystem enables low-power consumption modes such as hibernate with RTC mode, which requires approximately 7 μA of current. The CC3100MOD module can connect to any 8-, 16-, or 32-bit MCU over the serial peripheral interface (SPI) or universal asynchronous receiver/transmitter (UART) interface. The device driver minimizes the host memory footprint requirements of less than 7KB of code memory and 700B of RAM memory for a TCP client application. Figure 3 shows the CC3100MOD functional block diagram and Figure 4 shows the hardware overview.
3.1.2 TM4C123GH6PM

The Tiva™ C Series ARM Cortex-M4 microcontrollers provide top performance and advanced integration. The product family is positioned for cost-conscious applications requiring significant control processing and connectivity capabilities such as:

- Low power, hand-held smart devices
- Gaming equipment
- Home and commercial site monitoring and control
- Motion control
- Medical instrumentation
- Test and measurement equipment
- Factory automation
- Fire and security
- Smart Energy and Smart Grid solutions
- Intelligent lighting control
- Transportation

For applications requiring extreme conservation of power, the TM4C123GH6PM MCU features a battery-backed Hibernation module to efficiently power down the TM4C123GH6PM to a low-power state during extended periods of inactivity. With a power-up/power-down sequencer, a continuous time counter (RTC), multiple wake-from-hibernate options, a high-speed interface to the system bus, and dedicated battery-backed memory, the Hibernation module positions the TM4C123GH6PM microcontroller perfectly for battery applications. Figure 5 shows the TM4C123GH6PM high-level block diagram.

In addition, the TM4C123GH6PM microcontroller offers the advantages of ARM's widely available development tools, System-on-Chip (SoC) infrastructure IP applications, and a large user community. Additionally, the microcontroller uses ARM's Thumb®-compatible Thumb-2 instruction set to reduce memory requirements and, thereby, cost. Finally, the TM4C123GH6PM microcontroller is code-compatible to all members of the extensive Tiva™ C Series, providing flexibility to fit precise requirements.

Texas Instruments (TI) offers a complete solution to get to market quickly, with evaluation and development boards, white papers and application notes, an easy-to-use peripheral driver library, and a strong support, sales, and distributor network.
Figure 5. TM4C123GH6PM High-Level Block Diagram
Block Diagram

3.1.3 SN65HVD256

This CAN transceiver meets the ISO1189-2 high speed CAN physical layer standard. The transceiver is designed for data rates in excess of 1 Mbps for CAN in short networks and enhanced timing margin and higher data rates in long and highly-loaded networks. The device provides many protection features to enhance device and CAN network robustness. The SN65HVD257 adds additional features, allowing easy design of redundant and multi-topology networks with fault indication for higher levels of functional safety in the CAN system. Figure 6 shows the SN65HVD256 functional block diagram.

![Functional Block Diagram](image)

A Pin 5 function is device dependent: NC on SN65HVD255, VRXD for RXD output level-shifting device on SN65HVD256, and FAULT output on SN65HVD257

B RXD logic output is driven to 5-V \( V_{CC} \) on 5-V-only supply devices (SN65HVD255, SN65HVD257) and driven to VRXD on output level-shifting device (SN65HVD256)

C RXD (Receiver) Dominant State Time Out is a device dependent option available only on SN65HVD257.

Figure 6. SN65HVD256 Functional Block Diagram

3.1.4 TLV1117LV

The TLV1117LV series of low-dropout (LDO) linear regulators is a low-input voltage version of the popular TLV1117 voltage regulator.

The TLV1117LV is an extremely low-power device that consumes 500 times lower quiescent current than traditional 1117 voltage regulators, making the device suitable for applications that mandate very-low standby current. The TLV1117LV family of LDOs is also stable with 0 mA of load current. The device has no minimum load requirement, making it an ideal choice for applications where the regulator must power very small loads during standby in addition to large currents on the order of 1 A during normal operation. The TLV1117LV offers excellent line and load transient performance, resulting in very small magnitude undershoots and overshoots of output voltage when the load current requirement changes from less than 1 mA to more than 500 mA.

A precision bandgap and error amplifier provides 1.5% accuracy. A very high power-supply rejection ratio (PSRR) enables use of the device for post regulation after a switching regulator. Other valuable features include low output noise and low-dropout voltage.

The device is internally compensated to be stable with 0-Ω equivalent series resistance (ESR) capacitors. These key advantages enable the use of cost-effective, small-size ceramic capacitors. Cost effective capacitors that have higher bias voltages and temperature derating can also be used if desired.
The TLV1117LV series is available in an SOT-223 package. Figure 7 shows the TLV1117LV33 functional block diagram.

![Functional Block Diagram](image)

**Figure 7. TLV1117LV33 Functional Block Diagram**

### 3.1.5 TPD1E10B06 Single-Channel ESD in 0402 Package With 10-pF Capacitance and 6-V Breakdown

The TPD1E10B06 is a single-channel ESD protection device in a small 0402 package. The device offers over ±30-kV IEC air-gap, over ±30-kV contact ESD protection, and has an ESD clamp circuit with a back-to-back diode for bipolar or bidirectional signal support. The 10-pF line capacitance is suitable for a wide range of applications supporting data rates up to 400 Mbps. Typical application areas of the TPD1E10B06 include audio lines (microphone, earphone and speaker-phone), SD interfacing, keypad (or other buttons), and the VBUS pins of USB ports (ID).

The 0402 package is an industry standard and convenient for component placement in space-saving applications. The TPD1E10B06 is characterized for operation over an ambient air temperature of −40°C to 125°C. Figure 8 shows the TPD1E10B06 device configuration.

![Device Configuration](image)

**Figure 8. TPD1E10B06 Device Configuration**
3.1.6 TPD2E2U06 Dual-Channel High-Speed ESD Protection Device

The TPD2E2U06 is a dual-channel low capacitance TVS diode ESD protection device. The device offers ±25-kV contact and ±30-kV air-gap ESD protection in accordance with the IEC 61000-4-2 standard. The 1.5-pF line capacitance of the TPD2E2U06 makes the device suitable for a wide range of applications. Typical application interfaces are USB 2.0, LVDS, and I²C. Figure 9 shows the TPD2E2U06 functional block diagram.
4 System Design Theory

The TIDA-00380 reference design has three major circuits. The CAN interface is provided by the SN65HVD256 transceiver. The TM4C123GH6PM MCU manages the CAN processing and system controls. The CC3100 Wi-Fi module provides the Wi-Fi radio and internet protocol processing. The power conversion is provided by a TLC1117LV linear regulator. Figure 10 shows the TIDA-00380 circuit board partitions.

4.1 SN65HVD256 CAN Interface

A CAN interface requires a CAN transceiver. The SN65HVD256 transceiver is the optimum choice for this project because of its high speed, slow-transmit dominant time out \(t_{\text{TXD, DTO}}\), and its ability to interface with 3.3-V logic. The slow-transmit dominant time out allows a minimum data rate of 10 kbps. This slow data rate is useful in CANopen and other industrial applications. Resistors R18 and R19 provide the CAN bus termination of approximately 120 \(\Omega\). D14 provides additional electrostatic discharge (ESD) suppression to protect the transceiver. Connector J8 is a nine-pin male D-SUB connector. The CAN signal connections to J8 conform to the CANopen requirements. Figure 11 shows the CAN transceiver schematic of the SN65HVD256 device.
4.2 **TM4C123GH6PM System Processor**

The TM4C123GH6PM processor provides a powerful ARM® Cortex™ M4F processor with a variety of peripherals. For this design, the CAN and Synchronous Serial Interface (SSI) modules are used. The CAN module CAN0 enables the easy implementation of a CAN interface with speeds from 1 kbps to 1 Mbps and glueless attachment to the SN65HVD256 CAN transceiver. The SSI module SSI0 is used to implement a SPI to transfer data to and from the CC3100 module. The transfer speed for the SPI is set at 12 MHz.

The TM4C123GH6PM circuit has several other parts. J3 is a JTAG header for programming the processor. Switch S1 provides a manual reset for the processor. The crystal Y2 is a 16-MHz crystal used to generate the primary system clock. Y1 is a 32.768-KHz clock crystal which is not used in the application described here but is useful for applications that require a low power standby. The header J5 is a universal asynchronous receiver/transmitter (UART) connection. The purpose of this port is to allow a terminal connection to monitor or control the TM4C123GH6PM device.

The USB port on the TM4C123GH6PM device is not used, but the USB DP and DN signals are connected between the USB connector and the processor for possible future development. The TPD2E2U06 ESD protection device is included to provide ESD protection for the USB data lines. Figure 12, Figure 13, and Figure 14 show the complete TM4C123GH6PM schematic.

**Figure 12. TM4C123GH6PM Microcontroller Schematic**

![TM4C123GH6PM Microcontroller Schematic](image-url)
Figure 13. TM4C123GH6PM JTAG Connector Schematic

Figure 14. TM4C123GH6PM UART Terminal Connector Schematic
4.3 CC3100MOD Wi-Fi® Module

The CC3100MOD module encloses the CC3100 with its peripheral power supply, clock, and memory components in one easy-to-use package that is ideal for integrating with a host application processor. In this system, the CC3100MOD is used as an access point to which a computer or smartphone can connect. CAN data is transferred to and from a web page served to the client station.

Several pieces support the CC3100MOD in this design. S2 is a manual reset button and J10 is a UART connector for use with a USB-to-UART adapter. J10 is used for programming the CC3100 with its service pack and the web page templates used for the application described in Section 5. Components J4, R15, L4, C18, and E1 provide the radio frequency (RF) output for the system. E1 is a chip antenna. C19 is not populated but is included for situations that require antenna impedance matching.

J11 is included to configure the programming of the CC3100MOD. J11 must be shorted while programming and must remain unconnected for normal operation. Figure 15 shows the CC3100MOD schematic.

![Figure 15. CC3100MOD Schematic](image-url)
4.4 **Power Input and TLV1117LV 3.3-V Supply**

The power for the CAN-to-Wi-Fi gateway is the 5-V VBUS provided by the USB connector. The USB connector has no other purpose in this design. Connector J2 is provided to allow easy current measurement for the whole system. The 5-V VBUS is connected to the CAN transceiver through R2, which has been included to provide a place to measure current in this circuit branch. Components U2, C1, and D1 provide ESD protection and noise suppression. The light-emitting diode (LED) D5 is a power indicator.

The rest of the system is powered by 3.3 V. This 3.3 V is provided by the TLV1117LV33 linear regulator. The TLV1117LV has been chosen for its high current capacity and because it is stable with low equivalent series resistance (ESR) ceramic capacitors. The input capacitor C2 has a value of 100 µF, which has been chosen to ensure that the 5-V power line does not sag during high current transients. The output capacitors C4 and C5 (both 100 µF) are recommended by the CC3100MOD to help supply high current transients during Wi-Fi transmissions. R1 can be removed to measure the current in the 3.3-V supply. Figure 16 shows the power section of the schematic.

**Figure 16. Power Section**
5 Software Design

The application for the TIDA-00380 reference design has two basic functions:
1. Receive data from the CAN transceiver and display the data on a webpage
2. Receive data from the webpage and write the data to the CAN transceiver

The firmware is a modified http_server application, which has been written for use with the TM4C123 and the CC3100 devices. The http_server application demonstrates the capability of the CC3100 device to work as a web server and allows end-users to communicate with it using standard web browsers. Note that SDK version 1.1.0 for CC3100 silicon has been used as the code base and contains the function libraries for the TM4C123 device.

Figure 17 shows the software flow.
The webpage template is preloaded into the CC3100MOD SPI flash. The TM4C123 application starts by initializing both the CC3100MOD and CAN transceiver. The TM4C123 application then configures the CC3100 in access point (AP) mode with a predefined Service Set Identifier (SSID) name, “TIDA-00380_AP”. Before proceeding, the application waits for a client to connect to the access point. Upon connecting, the application displays the login authentication parameters on the terminal for the client to use. The client can then use any standard web browser to log in to the webpage with the provided authentication.

The webpage contains two sections: Send Packet and Log. In the Send Packet section, the user populates the CAN Identifier and Data fields with the desired data to send. When the button is clicked, the client sends a POST token to the application. The application receives the POST token, parses the CAN data from the POST token, and sends the CAN data onto the CAN network. In the Log section, the client periodically requests data from the application by sending a GET token. When the application receives the GET token, it responds with the CAN data. The client receives the response and updates the Log window accordingly.
6 Getting Started

6.1 Initial Setup

The CAN connection is made using a cable with female DB-9 connectors on each end. Connect one end of the cable to J8 on the TIDA-00380 circuit board. Connect the other end to the CAN network or a CAN emulator.

Power for the TIDA-00380 design is provided by a USB A-to-micro USB cable. Plug the micro USB connector into J1 on the TIDA-00380 circuit board. Plug the A side into a computer USB socket or into a standard USB charger to power the TIDA-00380 circuit board. Figure 18 shows the applicable connectors for the initial setup.

![Figure 18. Connectors](image)

6.2 Software Setup

The following steps describe the procedure to build and load binary onto the TM4C123 MCU, flash the CC3100 HTML pages, and test the system.

6.2.1 TM4C123 Setup

The following steps detail the process for the TM4C123 setup.

1. Open the TI Code Composer Studio™ (CCS) software and import the “TIDA-00380_Firmware” application.
2. Build the project:
   (a) Go to Project → Build project
3. Flash the binary:
   (a) Connect an XDS100v2 JTAG programmer to J3 on the CAN-to-Wi-Fi Gateway (see Figure 19)
   (b) Press the green bug icon, or Project → Debug to load the binary onto the TM4C123 MCU
Figure 19. JTAG and UART Connections for Programming

Figure 20. USB Cable for Power, XDS100v2, and UART-to-USB Connections for Programming
6.2.2 **CC3100 Setup**

1. Connect a USB-to-UART cable to J10
2. Look in the *Device Manager* module located in the Windows® Control Panel GUI and note the USB-to-serial COM port
3. Open CCS UniFlash program (see Figure 21)
4. In the menu toolbar, click *File* → *Open Configuration*
5. Click the *Browse* button and locate the *.ucf* file in the "webpage/uniflash_template" folder inside the TIDA-00380_Firmware project
6. Change the COM port to match the USB-to-serial COM port number

![Figure 21. CCS™ UniFlash Setup](image)
7. If it is the first time booting the hardware, format the CC3100MOD Flash memory and run the "Service Pack Update"
   (a) To format the Flash:
      (i) In CCS UniFlash, click the Format button
      (ii) For the memory size, choose 8MB (see Figure 22)

   ![Figure 22. CC3100MOD Flash Format Options](image)

   (b) To update the Service Pack:
      (i) Click "Service Pack Programming"
      (ii) Find the CC3100 Service Pack binary, which is usually located in
           C:\ti\CC31xx_CC32xx_ServicePack_x.x.x.x (see Figure 23). The version at the time of this writing is 1.0.0.10.0.

   ![Figure 23. Selection Window for CC3100 Service Pack](image)

8. Flash the HTML webpages by clicking on the Program button
9. At this point, the CAN-to-Wi-Fi HTML pages are loaded into the CC3100MOD SPI flash
6.2.3 Run Application

1. Remove USB-to-serial cable from J10 and connect to J5
2. Open a terminal with the following settings
   (a) Port: COM port from Device Manager
   (b) Baud Rate: 115200
   (c) Data: 8 bit
   (d) Parity: None
   (e) Stop: 1 bit
   (f) Flow control: None
3. Start the CAN-to-Wi-Fi application
   (a) Power on the CAN-to-Wi-Fi Gateway as Section 5 details
   (b) The terminal appears as in Figure 24

![Figure 24. Terminal Output from TM4C123](image)

4. Connect to the access point (AP)
   (a) Using a phone or laptop, connect to the SSID “TIDA-00380_AP” with WPA security. The password is “cantowifi”.
   (b) The terminal shows the authentication parameters upon connecting a device to the AP.
5. Connect to the webpage
   (a) Open a standard web browser and navigate to IP Address 192.168.1.1 or type “mysimplelink.net” in the browser address bar.
   (b) Log in with authentication parameters as shown by the terminal. By default, the username is “admin” and the password is also “admin”.
   (c) Click on the CAN tab to start sending and receiving CAN packets.
6. Webpage

(a) The following Figure 25 and Figure 26 show screen shots of the webpage from a laptop and a mobile phone.

![Figure 25. Webpage—Laptop View](image)

![Figure 26. Webpage—Mobile Phone View](image)

(b) The **Send Packet** section allows the user to enter the CAN packet information to be sent from the phone or laptop onto the CAN network.

(c) The **Log** section displays any packet that is also visible on the CAN bus, except for the packets that the user sends.
6.3 Communication Test

Note that the communication test uses a CAN sniffer to monitor packets being transmitted by the TIDA-00380 circuit board. The CAN sniffer also has the ability to transmit CAN packets into the network.

1. Connect the CAN sniffer to J8 of the CAN-to-Wi-Fi Gateway as Section 6.1 describes.
2. Power on the CAN-to-Wi-Fi Gateway as Section 6.1 describes.
3. Connect either a laptop or mobile phone to the AP as Section 6.2.3 describes.
4. Open a standard web browser and navigate to the CAN webpage, as Section 6.2.3 describes.
5. Open the CAN sniffer software and select the CAN sniffer hardware.
6. Send packets from the webpage and verify that the same identifier and data appears on the monitoring program for the CAN sniffer.
7. Send packets from CAN sniffer’s monitoring program and verify that the same identifier and data appears in the Log section of the webpage (see Figure 27).

![Figure 27. Example of CAN Sniffer Monitoring Software](image-url)
7 Test Data

7.1 Input Power

Figure 28 shows a physical image of the power test setup.

Figure 28. Power Test Setup

The system input voltage was measured across TP1 and TP5 of the TIDA-00380 circuit board (see Figure 29). For this test, a power supply output was set for a 5.0-V output. The power supply negative lead was attached to TP5 on the board. The positive output of the power supply was connected to a digital multimeter (DMM) set to measure current. The second DMM lead was connected to TP1 on the TIDA-00380 circuit board. The DMM was set to average the current. An oscilloscope with a current probe was used to measure the current transients. The current probe was clamped onto the power lead from the DMM to TP1.

Figure 29. Locations of Test Points Used During Power Tests
With the CAN to Wi-Fi Gateway system operating and a smartphone connected to the CC3100 AP, the average DC input current measured was 103.6 mA. The voltage measured across TP1 and TP5 was 5.03 V. The input power was 103.6 mA × 5.03 V = 521.1 mW.

Current draw in the CAN-to-Wi-Fi Gateway system is not constant. The current draw increases when Wi-Fi transmissions occur. Figure 30 shows an example of the dynamic current into the CAN-to-Wi-Fi Gateway system.

The peak current that Figure 30 shows is 330 mA. The peak current has a very short duration, so the average current is not significantly affected.

7.2 CAN 5-V Power Consumption

The CAN transceiver has two input power pins. The 3.3-V input is used for the digital interface that connects to the host processor. The 5-V input powers the CAN interface. The user can remove resistor R2 so that a DMM set to measure current can be connected to measure the 5-V current into the transceiver. The 5-V current was 10.4 mA. The current measured was the same if there were CAN transmissions or if the CAN bus was idle. The total power used by the CAN bus interface is 10.4 mA × 5.03 V = 52.3 mW.

7.3 TLV1117LV33 Output Power

The purpose of resistor R1 is to provide a place to measure the output current for the TLV1117LV33 regulator. DC output current is measured by removing R1 and connecting a DMM set to measure current across the pads for R1. Dynamic load current can be measured by soldering a loop of wire across the pads of R1. This loop must be big enough to allow an oscilloscope current probe to fit into the loop. The output voltage is measured between TP3 and TP5.

The DC output current was measured as 93.5 mA and the DC output voltage measured 3.302 V.
Figure 31 shows the dynamic output current measured with the oscilloscope current probe.

7.4 SPI

The SPI between the TM4C123 and the CC3100MOD is the link through which data communication between the two circuits occurs. Figure 32 shows the measurement of one SPI clock cycle.
The SPI clock period is 80 ns or 12.5 MHz. There are eight clock periods per word, so the word rate is 640 ns or 1.562 MHz. The chip select that enables the CC3100MOD SPI lasts for 724 ns (see Figure 33).

![Figure 33. SPI Chip Select (CS) Period](image)

7.5 **CAN Interface**

Figure 34 shows a typical transmission from the SN65HCD256 on the CAN bus. The data being sent is a string “01 02 03 04 05 06 07 08” that is input in the webpage displayed on the computer or phone.

![Figure 34. CAN Transmit from SN65HVD256](image)
The CAN interface is configured to run at 1 MHz. This can be verified by measuring the Start-of-Frame (SOF) pulse in a CAN transaction. The SOF synchronizes all CAN devices on a bus. Figure 35 shows the SOF time.

Figure 35 and Figure 36 show the measurements for the CANH and CANL amplitudes. CANH has an amplitude of 1.14 V. CANL has an amplitude of 1.24 V. The recessive level for both CANH and CANL is about 2.52 V.

The SOF period is 1.0 µs or 1 MHz.
8 Other Applications

The application created for this project tests only one possibility for the CAN-to-Wi-Fi Gateway hardware. There are other possibilities as well.

One possibility is to configure a second CAN-to-Wi-Fi Gateway board as a Wi-Fi station and connect it to the Wi-Fi network created by the CAN to Wi-Fi Gateway configured as an access point (see Figure 37). A second CAN bus can connect to the station board. The two CAN busses can then operate as one virtual bus. This configuration could be used as a cable replacement in places where routing cables would be difficult.

Another possibility is to create an application that connects the CAN to Wi-Fi Gateway hardware to an existing Wi-Fi network. Creation of this application allows remote access to the CAN network or network data storage in a cloud location (see Figure 38).

Figure 37. CAN-to-Wi-Fi® Gateway Configured as Cable Replacement

Figure 38. CAN-to-Wi-Fi® Gateway With Internet Cloud Interface
9 Design Files

9.1 Schematics
To download the Schematics for each board, see the design files at TIDA-00380.

9.2 Bill of Materials
To download the bill of materials (BOM) for each board, see the design files at TIDA-00380.

9.3 PCB Layout Recommendations
The layout of this PCB was done by carefully following the recommended guidelines for the TM4C123GH6PM, the CC3100MOD and for the Taiyo Yuden AH316M245001-T chip antenna. The power nets from J1 through to the 3V3 net are made as wide as practical. For the CC3100MOD, the Hardware Design Review Process and PCB Layout Design Guidelines found on the SimpleLink™ Wi-Fi® CC31xx/CC32xx Main Page must be followed for best results. Net connections between the components connected from the RF output of the CC3100MOD to the antenna are 50 Ω.

9.3.1 Layout Prints
To download the layout prints for each board, see the design files at TIDA-00380.

9.4 Altium Project
To download the Altium project files for each board, see the design files at TIDA-00380.

9.5 Gerber Files
To download the Gerber files for each board, see the design files at TIDA-00380.

9.6 Assembly Drawings
To download the assembly drawings for each board, see the design files at TIDA-00380.

10 Software Files
To download the software files for this reference design, see the design files at TIDA-00380.

11 References

1. Texas Instruments, TI E2E Community, Community Forum (http://e2e.ti.com/)
2. Texas Instruments, Tiva™ TM4C123GH6PM Microcontroller, TM4C123GH6PM Data Sheet (SPMS376)
3. Texas Instruments, CC3100MOD SimpleLink™ Certified Wi-Fi® Network Processor Internet-of-Things Module Solution for MCU Applications, CC3100MOD Data Sheet (SWRS161)
5. Texas Instruments, TLV1117LV 1-A, Positive Fixed-Voltage, Low-Dropout Regulator, TLV1117LV Data Sheet (SBVS160)
6. Texas Instruments, SN65HVD25x Turbo CAN Transceivers for Higher Data Rates and Large Networks Including Features for Functional Safety, SN65HVD25x Data Sheet (SLLSEA2)
7. Texas Instruments, TPD1E10B06 Single-Channel ESD Protection Diode in 0402 Package, TPD1E10B06 Data Sheet (SLLSEB1)
12 Terminology

AP—Access Point (this is the source for a Wi-Fi signal)

CAN—Controller Area Network

CANopen—A version of CAN intended for industrial applications

DMM—Digital Multimeter

Sniffer—In this document, the CAN sniffer is a piece of test equipment used to monitor CAN transmissions

13 About the Author

MARK KNAPP is a Systems Architect at Texas Instruments Incorporated where he is responsible for developing reference design solutions for the Building Automation segment. He has an extensive background in video camera systems and infrared imaging systems for Military, Automotive and Industrial applications. Mark earned his BSEE at the University of Michigan-Dearborn and his MSEE at the University of Texas at Dallas.

CHRISTINA S. LAM is a Systems Architect at Texas Instruments where she is responsible for developing firmware for reference design solutions in the industrial segment. Christina has broad experience with applications processors, microcontrollers, and digital-signal processors with specialties in embedded firmware. Christina earned her Bachelor of Science (BS) in Electrical and Computer Engineering from the University of Texas at Austin.
IMPORTANT NOTICE FOR TI REFERENCE DESIGNS

Texas Instruments Incorporated (“TI”) reference designs are solely intended to assist designers (“Buyers”) who are developing systems that incorporate TI semiconductor products (also referred to herein as “components”). Buyer understands and agrees that Buyer remains responsible for using its independent analysis, evaluation and judgment in designing Buyer’s systems and products.

TI reference designs have been created using standard laboratory conditions and engineering practices. TI has not conducted any testing other than that specifically described in the published documentation for a particular reference design. TI may make corrections, enhancements, improvements and other changes to its reference designs.

Buyers are authorized to use TI reference designs with the TI component(s) identified in each particular reference design and to modify the reference design in the development of their end products. HOWEVER, NO OTHER LICENSE, EXPRESS OR IMPLIED, BY ESTOPPEL OR OTHERWISE TO ANY OTHER TI INTELLECTUAL PROPERTY RIGHT, AND NO LICENSE TO ANY THIRD PARTY TECHNOLOGY OR INTELLECTUAL PROPERTY RIGHT, IS GRANTED HEREIN, including but not limited to any patent right, copyright, mask work right, or other intellectual property right relating to any combination, machine, or process in which TI components or services are used.

Information published by TI regarding third-party products or services does not constitute a license to use such products or services, or a warranty or endorsement thereof. Use of such information may require a license from a third party under the patents or other intellectual property of the third party, or a license from TI under the patents or other intellectual property of TI.

TI REFERENCE DESIGNS ARE PROVIDED “AS IS”. TI MAKES NO WARRANTIES OR REPRESENTATIONS WITH REGARD TO THE REFERENCE DESIGNS OR USE OF THE REFERENCE DESIGNS, EXPRESS, IMPLIED OR STATUTORY, INCLUDING ACCURACY OR COMPLETENESS. TI DISCLAIMS ANY WARRANTY OF TITLE AND ANY IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, QUIET ENJOYMENT, QUIET POSSESSION, AND NON-INFRINGEMENT OF ANY THIRD PARTY INTELLECTUAL PROPERTY RIGHTS WITH REGARD TO TI REFERENCE DESIGNS OR USE THEREOF. TI SHALL NOT BE LIABLE FOR AND SHALL NOT DEFEND OR INDEMNIFY BUYERS AGAINST ANY THIRD PARTY INFRINGEMENT CLAIM THAT RELATES TO OR IS BASED ON A COMBINATION OF COMPONENTS PROVIDED IN A TI REFERENCE DESIGN. IN NO EVENT SHALL TI BE LIABLE FOR ANY ACTUAL, SPECIAL, INCIDENTAL, CONSEQUENTIAL OR INDIRECT DAMAGES, HOWEVER CAUSED, ON ANY THEORY OF LIABILITY AND WHETHER OR NOT TI HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES, ARISING IN ANY WAY OUT OF TI REFERENCE DESIGNS OR BUYER’S USE OF TI REFERENCE DESIGNS.

TI reserves the right to make corrections, enhancements, improvements and other changes to its semiconductor products and services per JESD46, latest issue, and to discontinue any product or service per JESD48, latest issue. Buyers should obtain the latest relevant information before placing orders and should verify that such information is current and complete. All semiconductor products are sold subject to TI’s terms and conditions of sale supplied at the time of order acknowledgment.

TI warrants performance of its components to the specifications applicable at the time of sale, in accordance with the warranty in TI’s terms and conditions of sale of semiconductor products. Testing and other quality control techniques for TI components are used to the extent TI deems necessary to support this warranty. Except where mandated by applicable law, testing of all parameters of each component is not necessarily performed.

TI assumes no liability for applications assistance or the design of Buyers’ products. Buyers are responsible for their products and applications using TI components. To minimize the risks associated with Buyers’ products and applications, Buyers should provide adequate design and operating safeguards.

Reproduction of significant portions of TI information in TI data books, data sheets or reference designs is permissible only if reproduction is without alteration and is accompanied by all associated warranties, conditions, limitations, and notices. TI is not responsible or liable for such altered documentation. Information of third parties may be subject to additional restrictions.

Buyer acknowledges and agrees that it is solely responsible for compliance with all legal, regulatory and safety-related requirements concerning its products, and any use of TI components in its applications, notwithstanding any applications-related information or support that may be provided by TI. Buyer represents and agrees that it has all the necessary expertise to create and implement safeguards that anticipate dangerous failures, monitor failures and their consequences, lessen the likelihood of dangerous failures and take appropriate remedial actions. Buyer will fully indemnify TI and its representatives against any damages arising out of the use of any TI components in Buyer’s safety-critical applications.

In some cases, TI components may be promoted specifically to facilitate safety-related applications. With such components, TI’s goal is to help enable customers to design and create their own end-product solutions that meet applicable functional safety standards and requirements. Nonetheless, such components are subject to these terms.

No TI components are authorized for use in FDA Class III (or similar life-critical medical equipment) unless authorized officers of the parties have executed an agreement specifically governing such use.

Only those TI components that TI has specifically designated as military grade or “enhanced plastic” are designed and intended for use in military/aerospace applications or environments. Buyer acknowledges and agrees that any military or aerospace use of TI components that have not been so designated is solely at Buyer’s risk, and Buyer is solely responsible for compliance with all legal and regulatory requirements in connection with such use.

TI has specifically designated certain components as meeting ISO/TS16949 requirements, mainly for automotive use. In any case of use of non-designated products, TI will not be responsible for any failure to meet ISO/TS16949.